
WaveTracker 1.0 Quick Guide 
Covers version 1.01, December 2001 
 
Please direct questions, bug reports, and feature requests to larry@plexonin.com. 
 
 
Overview 
 
WaveTracker is a Windows NT/2000 app that allows you to extract the waveforms from one or more plx 
recording files, in order to view and track the changes in the waveforms over time, and to verify the 
proper separation of sorted units.  The extracted waveforms can be saved in a WaveTracker file (.wt), 
independent of the original plx files, and waveforms from additional plx files can be appended to the .wt 
file.  If WaveTracker shows that units have "gone bad," merged or swapped with other units on a DSP 
channel, editing functions allow the user to delete or swap sections of waveform data and generate new, 
corrected plx files from the original plx files.  Waveform and PCA cluster statistics can be exported as a 
text file, and the various WaveTracker views can be printed. 
 
For brevity, WaveTracker will be referred to as WT from here on. 
 
 
Installation 
 
The executable files you need to run WT are: 
 
    wt.exe (main WT executable) 
    OT602as.dll (support library) 
    OSC61as.dll (support library) 
 
You should already have an MFC4*.dll somewhere in your Windows or Windows\system32 directories.  
These files are usually present on most people's systems as a result of having been installed by other 
applications such as Nex, MS Word, etc..  The DLL must be version 4.2 or greater, e.g. MFC42.DLL, 
MFC43.DLL, etc.  If you don't have the MFC files, contact larry@plexoninc.com. 
 
Create a directory such as \Plexon\WaveTracker and copy wt.exe, OT602as.dll, and OSC61as.dll into the 
directory.  Double-click on wt.exe to start WT.  It should look something like this: 
 



 
 
You can resize the window and use the splitter bars (between the spreadsheet-like grid and the displays to 
its right and below it) to rearrange things.  When you shut down WT and restart it, the last window 
settings are restored.  You can also use the Customize command in the Tools menu to change the 
appearance of the toolbar.  The colors used in the graphic displays (e.g. a,b,c,d unit colors) can be 
changed in the Colors tab of the Options dialog.  This Quick Start guide assumes that you are using the 
default color and toolbar setup. 
 
 
Loading PLX Files 
 
Click on the leftmost icon in the WT toolbar, the open-file button that reads "PLX."  A file-open dialog 
appears.  Open one or more .plx files.  You can shift-click or ctrl-click to select as many as you like, in 
any order.  WT will sort them into ascending time order when it loads them.  The plx files need not have 
the same number of DSP channels or the same number of sorted units on each channel. 
  



Note: WT never alters the original plx files; it extract waveforms from them which it can save into its own 
waveform tracking database, the .wt file.  The WT database can be used as an "edit list" for creating new 
versions of the original plx files with sections deleted, unit assignments swapped, etc., but this isn't 
covered in this Quick Start guide.   
 
The Scan PLX File dialog box appears:  
 

 
 
 
The plx file (or the earliest plx file if you selected more than one in the file open dialog) is automatically 
pre-scanned and "mini-rasters" correponding to the waveforms found in the file are displayed in the small 
window.  Each row of red lines or dots is one DSP channel (a+b+c+d units).  The red dots/lines are 
overlaid on alternating green and black vertical bars.  The width of the bars represent the extract intervals 
and skip intervals, for breaking long files up into "segments" on each channel, each segment being 
represented as a single PCA ellipse, mean waveform, etc., in WT.  However, the default is 60 second 
extract intervals with no gaps in between, in which case the extract intervals are separated with vertical 
black lines.  You can use the up/down arrows next to the Extract time and Skip time to change the 
duration of the segments and the gaps between them.  e.g. if the extract time is 60 seconds and the skip 
time is 0 seconds, a 10 minute long file will be represented as ten one minute long segments.  The idea is 
to make each segment long enough to be able to calculate reliable PCA ellipses and other statistics from it, 
while at the same time avoiding reading every waveform from a large file into memory.  All channels will 
be have their waveforms extracted using the same intervals in parallel.  After setting the parameters for 
extracting waveforms, you can click Extract as multiple smaller segments to extract the waveforms into 
WT.  There is currently a limit of 1024 segments per channel. 
 
For short files, such as "waveform sample" files made at the start of each day's experiment, you can 
choose to not subdivide the data into segments, and simply click the Extract as one segment per channel 
button.  The entire file, no matter how long, will then be represented in WT as a single segment with one 
mean waveform, PCA ellipse, etc.  You can later split the single segment into smaller ones if desired, but 
be careful about trying to load extremely large files. 



 
You can use the Max wfs/segment and Min wfs/segment options to set a limit on the size of a segment of 
waveforms.  If an extract interval contains more than the maximum number of waveforms, the first N 
waveforms are extracted and the remainder in the interval are ignored by WT.  Note that the Enable 
waveform limits option must be checked for the min and max options to apply. 
 
The Include unsorted waveforms option determines whether unsorted units are loaded into WT or ignored.  
For example, you may wish to load the unsorted waveforms to verify that the sorted units are clearly 
separated from the unsorted, or to view the unsorted waveforms. 
 
If you opened multiple plx files in the file open dialog, the Scan PLX File dialog appears for each one.  
You can click Extract as multiple segments or Extract as one segment for each.  The extract and skip time 
settings are maintained from the previous file but can be changed for each file if desired.  When all the 
files have been read, a summary of the extracted waveforms is displayed in the spreadsheet-like grid, for 
example: 
 

 
 
 
For large files, it may take a few seconds between when the last plx file is read and when the grid is 
updated. 
 
By default, the first segment of every unit channel is selected for viewing after you have loaded a plx file: 
 



 
 
 
The Grid and Selections 
 
The spreadsheet-like grid is the main interface for selecting which waveform segments you want to view.  
The first five columns are fairly self-explanatory.  To the right of these are the columns representing the 
unit channels.  Click on a column header (e.g. DSP21c) to select all the segments for that unit.  Click on 
an individual segment to select only that segment.  Mouse-down and drag within one or more columns to 
select a rectangular block of waveform segments, e.g. segments 13-18 on DSP21b through DSP21d.  
Selecting disjoint runs of segments within one channel, or entire channels, or rectangular areas within the 
channel columns, are all supported.     
 
You can also use the arrow keys to move around in the grid.  This can be handy for viewing successive 
segments of data as you go up or down a single channel's column in the grid.  For example, if you select 
the first segment on DSP04a,b,c,d and then hit the down arrow key, the second segment on all four unit 
channels are selected, so you can easily step through the data in time. 



 
Selecting the filename of a single plx file in the leftmost grid column automatically selects the first 
segment on every unit channel.  Also note that you must select a filename in the grid in order to access 
some functions related to individual plx files; for example, deleting a plx file from WT, or saving the plx 
with edits. 
 
 
Waveform Views 
 
The selection in the grid determines what subset of the extracted waveform data is shown in the graphical 
displays.  The view to the right of the grid is a tabbed window -- the tabs at the bottom choose the 2D 
waveform view, the 2D PCA view, or the 3D waveform or PCA view.  If you don't see all three tabs, drag 
the mini-splitter bar that is at the right of the tabs until all the tabs are accessible.  You can switch 
between the tabbed views at any time.  The area at the bottom of the screen, below the grid and the tabbed 
window,  shows the single-channel display and the mini-PCA display to its right.  Unlike the tabbed 
window, these two displays always show a single DSP channel (of up to four unit channels); if more than 
one DSP channel is selected in the grid, the lowest numbered one is displayed.  Similarly, the 3D views 
show up to four unit channels on the lowest-numbered selected DSP channel.  2D views can show any 
number of selected DSP channels.  To select the type of view to see in the main window, you can use these 
toolbar buttons: 
 

 
 
These select the view type: (from left to right) 2D waveforms, 3D waveforms, 2D PCA clouds, 3D PCA 
clouds, 3D PCA ellipsoids, and 3D principal component stability tubes (PCST). 
 
 
2D Waveform View 
 
Each segment of data is shown as one pane in the 2D waveform view.  If you click on one of the panes, 
only that single segment is selected in the grid, and the 2D waveform view zooms to show only that 
segment:  
 

 
 



The 2D waveform view shows any combination of the following items, which can be toggled on and off by 
clicking on the buttons labeled R,M,T,PC1,PC2,PC3,E, and SD in the toolbar: 
 

 
 
(R)aw waveforms - The actual extracted waveforms, displayed in green.  Note that you can set a 
maximum number of waveforms to be drawn per segment in the 2D Waveforms tab of the Options dialog.  
This does not affect analyses in any way; it is merely provided to speed up redrawing of segments with 
many waveforms. 
 
(M)ean waveform - The mean waveform for all the waveforms in the segment, displayed in red. 
 
(T)emplate waveform - The template that the MAP used to sort the waveforms, displayed in light blue.  If 
the channel was sorted with boxes instead of templates, the template will be a flat line. 
 
PC1, PC2, and PC3 are the first, second, and third principal component waveforms.  The principal 
component waveform is by default calculated from the waveforms in the first segment on each unit 
channel, referred to as the base segment.  Waveforms in later segments on a given channel are then 
projected onto the PC waveform from the base segment to obtain a "PCA point" per waveform, which 
typically form clusters in the 2D and 3D PCA views.  You can set a different base segment by selecting an 
entire row across all channels (click on a row number at the far left column of the grid) and selecting "Set 
as base for PCA" from the right-button popup menu.  For example, you may need to do this if the first 
segment has few waveforms or has artifacts because electrodes were being adjusted, trials had not begun, 
etc.  In such a case, try to select a segment (grid row) in which all unit channels have many waveforms, so 
that the base PCA waveform is meaningful.  Note that there is by definition only a single PC1 waveform 
(or PC2, or PC3) for each unit channel; if you have more than one segment selected on a unit channel, the 
base segment's PC waveform(s) are shown on every segment that you have selected. 
 
(E)nvelope - The envelope of the minimum and maximum values of all waveforms in the segment, i.e. 
upper and lower polylines that just enclose all the waveforms in the segment, displayed in yellow. 
 
(S)tandard (D)eviation - Upper and lower polylines that show the mean waveform plus and minus three 
standard deviations (this value can be changed in the Options dialog) from the mean waveform at each 
sample point along the waveform, displayed in magenta/purple. 
 
Options for the 2D waveform view can also be set in the 2D Waveforms tab of the Options dialog: 
 



 
 
 
 
2D PCA View 
  
The 2D PCA display show PCA dot clusters and ellipses for the selected DSP channels:  
 

 
 



You can select a single segment to see only the PCA dots for that segment, along with a single ellipse 
representing three standard deviations in the major-axis and minor-axis directions (again, this value can 
be changed in the Options dialog).  If you select multiple segments, you will see as many ellipses as there 
are selected segments.  By default, the 2D PCA view shows PC1 and PC2, but you can view any two of the 
three components via these toolbar buttons: 
 

 
 
 
Note that the mini-PCA display (see below) always shows PC1 and PC2.  You can zoom in and out of the 
PCA view using these toolbar buttons: 
 

 
 
 
The PCA dots for each segment are calculated as needed, so there can be a slight delay the first time you 
view the PCA, especially if many channels or segments are selected.  After this initial calculation, 
subsequent displays of the same PCAs are faster. 
 
Options for the 2D PCA view can be set in the PCA tab of the Options dialog: 
 

 
 
 
 
3D Waveform View 
 



The 3D waveform view shows the mean waveform and per-segment standard deviation as a 3D surface: 
 

 
 
 
You can view the units for one DSP channel at a time.  Up to four units are displayed, each as a separate 
surface stacked vertically:  bottom to top is a,b,c,d., and each strip (including a selection strip described 
later) represents the mean waveform for one segment.   Three standard deviations in amplitude are also 
shown for each mean waveform; this can be toggled on and off using the SD toolbar button. 
 
Options for the 3D waveform view can be set in the 3D Waveforms tab of the Options dialog: 
 



 
 
 
 
3D PCA Clouds View 
 
The 3D PCA clouds view shows all three principal components for the selected segments, with each 
waveform represented by one PCA dot in 3D space: 
 



 
 
 
You can view the units for one DSP channel at a time.  Up to four units are displayed, with the PCA dots 
for each in the corresponding color.  Each of the three visible planes (floor and "walls") represents a 
combination of two of the three components.  The 3D PCA cloud is projected onto the floor and walls, 
showing all combinations of components simultaneously in a single view.   There are options for disabling 
the various projections and ellipses if the display becomes too cluttered.  Options for the 3D PCA clouds 
view can be set in the 3D PCA tab of the Options dialog: 
 

 



 
 
 
3D PCA Ellipsoids View 
 
The 3D PCA Ellipsoids view is similar to the 3D PCA clouds view, but instead of the raw 3D PCA dot 
clusters, ellipsoids are displayed, one ellipsoid per selected segment per unit channel, with the radii of 
each ellipse being equal to three standard deviations within the 3D PCA cloud: 
 

 
 
 
Note that if multiple segments are selected, the aggregate of the ellipsoids for the segments can be an 
arbitrarily lumpy surface: 
 



 
 
 
Options for the 3D PCA ellipsoids view can be set in the 3D PCA tab of the Options dialog. 
 
 
 
PCST View 
 
The PCST (Principal Component Stability Tube) display shows the change in any two of the three PCA 
components over time.  Each tube is one unit's PCA changing over time as you go along the vertical axis 
of the tube:  
 



 
 
 
The PCST clearly shows varying unit separation over time.  Ideally, none of the PCST tubes on a given 
DSP channel should touch each other.  In addition, any one PCST tube should not have any abrupt 
discontinuities over time; for example, if the ellipse representing one segment in the middle of a tube is 
much larger than the preceding and following segments, this would indicate that the waveforms in that 
segment have a much higher variance than the other segments' waveforms. 
 
There are numerous options for customizing the PCST display; for example, the PCST can be displayed as 
a stack of discs rather than as a continuous tube: 
 



 
 
 
Options for the PCST view can be set in the PCST tab of the Options dialog. 
 

 
 
 
 
 
Using 3D Views 
 



The 3D waveform, 3D PCA, and PCST views are OpenGL displays that you can interact with using the 
mouse and keyboard to change the view.  You must click anywhere in the 3D view before you can interact 
with it.  At any time, if the view becomes confusing ("where did everything go??"), you can press the 5 
key in the middle of the numeric keypad to restore a default view.   
 
Holding down the left mouse button and moving the mouse to the left and right rotates the display left and 
right.  Moving the mouse up and down moves the viewpoint up and down, while still looking at the same 
"target," so that if you move far enough up, you are looking down somewhat from a high "vantage point."  
If you use the mouse to move down far enough, you will eventually be looking up at the underside of the 
"ground plane" grid and won't be able to see the main graphics.  Hold down the right mouse button and 
drag up and down to zoom in and out. 
 
You can move (translate) left, right, up, or down by holding down shift while moving the mouse.  The 
arrow keys also allow you to move left, right, up, or down, without using the mouse.  Press the + and - 
keys in the numeric pad to increase or decrease the sensitivity of mouse movements.  For example, each 
time you press + increases the sensitivity of subsequent mouse movements.  When you press the 5 key in 
the numeric pad, the mouse sensitivity is returned to its default setting, along with the default viewpoint. 
 
Both the PCST and 3D waveform views show represent each segment by a strip or band.  In the case of 
the 3D waveform view, each strip is the mean waveform for the segment.  For the PCST, each band/ring 
is the PCA ellipse for that segment.  The non-colored (white or black) narrower strip is the actual data as 
just described; the colored strips in between serve to connect them into a tube (unless you've chosen the 
"Discs" option in the PCST options or "Strips" in the 3D Waveform options).  In other words, don't infer 
anything from the colored regions between the white/black strips; these are simply a linear interpolation 
of the mean waveforms or PCA ellipses on either side.  Note that you can adjust the relative thickness of 
the strips, and other cosmetics, in the Options dialog. 
 
As you select segments within channels in the grid display, you will note that the selected segments are 
displayed as black strips/bands in the 3D views, and unselected segments are shown in white, just as the 
selected segments in the grid are in black.  You can also click directly on the strips/bands in the 3D 
display, and the corresponding segments will be selected in the grid.  For example, you could click on a 
PCST slice which looks questionable, then switch to the 2D Waveform view to examine the waveforms in 
that segment.  If you have trouble selecting by clicking on the selection strips in 3D, you can use the 
Options dialog to increase the relative size of the strips/bands to make them easier to select. 
 
Note that all 3D displays share a single tabbed window, 3D Surfaces.  Select either the 3D Waveform 
(surface) view or the PCST view by clicking on the buttons in the toolbar. 
 
A few graphics cards may have an OpenGL driver bug which results in the WT 3D views not being 
properly redrawn when the splitter bar between the data grid and the 3D view is moved to the left, 
enlarging the 3D view.  This typically exhibits as a black vertical strip at the right edge of the 3D view 
never being redrawn.  If this occurs, check with your graphics card manufacturer to see if a more recent 
Windows display driver is available, which should fix the problem.  If a new driver does not fix the 
problem, contact Plexon for a workaround. 
 
 
Single-channel linear display and mini-PCA display 
 
The single-channel view at the bottom of the window shows line graphs of either voltage levels 
(amplitudes), any combination of the first three principal components, or the F values (PC cluster 
separation) for selected segments of waveforms on one DSP channel.  To the left of the display, you can 
choose which quantity is displayed and whether it is graphed on a per-segment or per-waveform basis.  
For example, in this display, the minimum and maximum amplitudes are shown for every waveform on 
four unit channels in six selected segments.   



 

 
 
Note that the mini-PCA display shows a simplified version of the full PCA view.  Only PCA ellipses are 
drawn, without the clusters of dots.  PC1 and PC2 are always displayed, regardless of which of the three 
principal components is shown in the large PCA display. 
 
In the example below, only one unit channel ('a' in this case) is selected, and per-segment display is 
selected, so a single point is graphed per segment, rather than a point per waveform in the display above.  
The dotted lines indicate +/- one standard deviation. 
 
Also note that you can adjust the graph scaling using the Min and Max controls.  The min and max values 
are remembered for each different graph type (amplitude, principal components, and F values), so that 
when you switch from one type to another, the last min and max values you set for that type are recalled 
automatically. 
 

 
 
The MANOVA F statistic, which is a measure of separation of the principal component clusters for the 
units on a given DSP channel, can be viewed for either PC1 and PC2 or for all three components.  In 
other words, the cluster separation can be measured for the PCA ellipses defined by the first two 
components, or for the PCA ellipsoids defined by the first three components.  Note that the dotted line 
corresponds to an F value of 2.3, which corresponds to p < .01 for a typical number of waveforms per 
segment.  That is, an F value > 2.3 indicates clean separation between PCA ellipses or ellipsoids.   
 
Note: F is calculated as follows.  Wilkes' lambda is given by the ratio of determinants det(W)/det(T), 
where the W matrix represents the variance within a cluster, and the T matrix represents the total 
variance.  F is then derived from Wilkes' lambda using Rao's method.   
 



 
 
 
Full grid display 
 
Clicking on the Full Grid button in the toolbar switches the grid into a mode where detailed statistics can 
be viewed, including the values of the principal components, the corresponding percentage of variance, 
the F statistic and degrees of freedom, and various amplitude statistics.  Note that in this grid display, if 
you try to select a column other than a "dspxxx" column, the nearest DSP column to the left is taken as 
the selected unit channel.  It is generally more convenient to select channels and segments in the compact 
grid view. 
 

 
The items that are displayed in the Full Grid view can be customized in the Data Grid tab of the Options 
dialog.  Note that this is also where you can indicate whether or not to include unsorted units in the 
calculation of F values.  By default, unsorted units are not used in the calculation of F. 
 



 
 
 
 
Exporting statistics 
 
All waveform statistics can be exported as an ASCII text file for use by other programs, using the Export 
Statistics as Text File command in the File menu.  The Export tab of the Options dialog allows you to set 
the format in which the file will be saved, either segment-at-a-time or channel-at-a-time. 
 



 
 
 
 
Printing 
 
Any of the graphical views, both 2D and 3D, may be printed.  You can control which unit channels and 
waveform segments are printed simply by making the appropriate selection in the data grid before 
printing.  You can customize the colors used and other options in the Printing tab of the Options dialog.  
The color options allow you to set separate color schemes for screen display (in the Colors tab) and 
printing (Printing tab).  Draw first N wfs will cause only the specified number of waveforms (per unit 
channel) to be printed; likewise, Draw first N PCA dots restricts the number of dots printed per unit 
channel.  These options are handy for printing a small representative sample of waveforms or PCA dots.   
 
Note that printing the 3D views can cause a large amount of data to be sent to the printer and printing 3D 
views can be very slow for some output devices. 
 



 
 
 


